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1  Introduction

System Description 

Your new Level TROLL is a compact, modular system for measuring 
level and temperature in natural groundwater and surface water, as well 
as industrial, waste, and other installations. Components include the 
instrument body, vented and non-vented cables, communication cables, 
external power accessories, desiccants and other installation accessories, 
and software.

How to Use This Manual

This operator’s manual is designed as a start-up guide and a permanent 
reference for the Level TROLL’s features and applications. 

Section 1: Introduction to the Level TROLL Operator’s Manual and 
to In-Situ Inc. — Warranty Provisions — Instrument Repair & Return 
Recommendations
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Section 1: Introduction

Section 2: Components and features of the Level TROLL system 
— Accessories — Product Specifications

Section 3: Getting Started — Select a TROLL Com — Install the Software  
— Connect the Hardware

Section 4: Using Win-Situ — Connecting for the First Time — Setting the 
Clock  — Setting a Device Site — Preparing to Log Data —Disconnecting

Section 5: About the Pressure (Level) Sensor: The two basic types of 
pressure sensors — Factory and field calibration

Section 6: Field Installation — Guidelines and Precautions for Long-Term 
Deployment of the Level TROLL

Section 7: The BaroTROLL

Section 8: Connecting for use with SDI-12, Analog (4-20 mA), and Modbus 
loggers and controllers

Section 9: Care & Maintenance

Section 10: Troubleshooting

Conventions

Throughout this operator’s manual you will see the following symbols.

The check mark highlights a tip about a convenient feature of the Level 
TROLL.

The exclamation point calls your attention to a requirement or important 
action that should not be overlooked.
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TIP: Please 
save packing 
materials for 

future storage and shipping 
of your Level TROLL. 
The shipping boxes have 
been performance-tested 
and provide protection 
for the instrument and its 
accessories.

Section 1: Introduction

Certification

The Level TROLL complies with all applicable directives required by CE 
and the FCC and found to comply with EN 61326, ICES-003, and FCC 
Part 15 specifications. Declarations of conformity may be found at end of 
this manual.

Unpacking and Inspection

Your Level TROLL was carefully inspected before shipping. Check for any 
physical damage sustained during shipment. Notify In-Situ and file a claim 
with the carriers involved if there is any such damage; do not attempt 
to operate the instrument. Accessories may be shipped separately and 
should also be inspected for physical damage and the fulfillment of your 
order. 

Serial Number

The serial number is engraved on the body of the Level TROLL. It is 
also programmed into the instrument and displayed when the instrument 
is connected to a computer running Win-Situ® 5 or Win-Situ® Mobile 
Software. We recommend that owners keep a separate record of this 
number. Should your Level TROLL be lost or stolen, the serial number is 
often necessary for tracing and recovery, as well as any insurance claims. 
If necessary, In-Situ maintains complete records of original owner’s names 
and serial numbers.
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Section 1: Introduction

Bob Blythe, President and CEO 
In-Situ Inc. 
bblythe@in-situ.com

To Our Customers . . .

Thank you for your purchase of an In-Situ product.  We are glad you chose us and our products 
to help you with your environmental monitoring needs.  In-Situ Inc. has been designing and 
manufacturing world-class environmental monitoring instrumentation for over 25 years in the Rocky 
Mountains of the United States.  As it was in the beginning, our expectation is that this product will 
provide you with many trouble-free years of use.  To that end, we pride ourselves on delivering 
the best customer service and support possible—24 hours a day, 7 days a week.  We believe that 
this level of commitment to you, our customer, is imperative in helping you ensure clean, safe 
groundwater and surface water resources across the globe.  We also understand the need for 
accurate, reliable assessments and we continue to make significant investments in Research and 
Development to ensure that we deliver the latest product and technological innovations to support 
your needs. 

Whether you are gathering information about your body of water for a few moments, or over 
a period of years, you can rely upon us to provide you with a quality product and outstanding 
customer support at a fair price and have that product delivered to you when and where you need 
it.  

We want your experience with In-Situ Inc. to be pleasant and professional, whether you are renting 
from us, or purchasing from us.  We would be pleased to hear from you and learn more about your 
needs, and your experiences with our products. Again, we thank you for choosing In-Situ Inc. and 
we look forward to serving your needs now, and in the future.
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TIP: Maintenance 
& calibration 
plans as well as 

extended warranties are 
available for U.S. customers. 
Contact your In-Situ 
representative for more 
information.

Section 1: Introduction

What We Provide

Warranty Provisions

In-Situ® Inc., (In-Situ) warrants that all new instruments manufactured by it 
shall be free from defects in materials and workmanship for a period of:

One (1) year: Level TROLL•	 ® 300

Two (2) years: Level TROLL•	 ® 500, Level TROLL® 700, and 
BaroTROLL®

when properly installed and operated in accordance with the instruction 
manuals provided by, or available through, In-Situ Inc., and when used 
within the design specifications for the product. Products and accessory 
products including batteries, which are manufactured by others, carry 
the warranty of that manufacturer, or 30 days, whichever is greater. The 
warranty period for all products begins on the day the product is shipped 
to the customer or distributor.

The complete Warranty Policy is available on the In-Situ website.

How to Contact Us
Technical Support:	 800 446 7488, option 3
Toll-free 24 hours a day in the U.S.A. and Canada
Address:	 In-Situ Inc.
	 221 East Lincoln Ave.
	 Fort Collins, CO 80524
	 U.S.A.
Phone:	 970 498 1500
Fax:	 970 498 1598
Internet:	 www.in-situ.com
e-mail:	 support@in-situ.com
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Section 1: Introduction

To Obtain Repair Service (U.S.A.)
If you suspect that your Level TROLL is malfunctioning and repair is required, you 
can help ensure efficient servicing by following these guidelines: 

1.	 Call or e-mail In-Situ Technical Support (support@in-situ.com). Have the 
equipment with you when you call.

2.	 Be prepared to describe the problem, including how the instrument was used 
and the conditions noted at the time of the malfunction. 

3.	 If Tech Support determines that service is needed, they will ask that you 
download and complete a Return Materials Authorization Form available on 
the In-Situ website under Contacts/Returns for Service.

4.	 Clean the instrument and cable. Decontaminate thoroughly if it has been used 
in a toxic or hazardous environment.  See the Cleaning Guidelines and form 
on page 13.

5.	 Remove all sensors and accessories that are not required for the repair prior 
to returning the unit. 

6.	 Mark the RMA number clearly on the outside of the box with a marker or label.

Please keep your RMA number for future reference. Return unit for repair to the 
following address:

	 In-Situ Inc. 
ATTN: RMA #XXXXX 
221 E. Lincoln Ave. 
Fort Collins, CO 80524

To reduce waste, please use your original shipping container, if it is in good 
condition

The warranty does not cover damage during transit. We recommend the customer 
insure all shipments. Warranty repairs will be shipped back prepaid.

TIP: Please 
keep your RMA 
number for future 
reference.
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If an instrument 
returned for 
servicing 

shows evidence of 
having been deployed 
in a toxic or hazardous 
environment, Customer 
Service personnel will 
require written proof of 
decontamination before 
they can service the unit.

Section 1: Introduction

Outside the U.S.A.

Contact your international In-Situ distributor for repair and service 
information.

Guidelines for Cleaning Returned Equipment

Please help us protect the health and safety of our employees by cleaning 
and decontaminating equipment that has been subjected to any potential 
biological or health hazards, and labeling such equipment. Unfortunately, 
we cannot service your equipment without such notification. Please 
complete and sign the form on page 13 (or a similar statement certifying 
that the equipment has been cleaned and decontaminated) and send it 
along to us with each downhole instrument. 

•	 We recommend a good cleaning solution, such as Alconox®, a 
glassware cleaning product available from In-Situ (Catalog No. 
0029810) and laboratory supply houses. 

•	 Clean all cabling. Remove all foreign matter.

•	 Clean cable connector(s) with a clean, dry cloth. Do not submerge. 

•	 Clean the probe body—including the nose cone, cable head, and 
protective caps. Remove all foreign matter.

If an instrument is returned to our Service Center for  
repair or recalibration without a statement that it has been 
cleaned and decontaminated, or in the opinion of our Service 
Representatives presents a potential health or biological 
hazard, we reserve the right to withhold service until proper 
certification has been obtained.

TIP: Alconox® is  
available from  
In-Situ Inc. 

(Catalog No. 29810).
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Section 1: Introduction

Company Name_____________________________________________Phone_ _______________________

Address________________________________________________________________________________

City_ __________________________________ State_ ________________ Zip_______________________

Instrument Type____________________________________Serial Number___________________________

Contaminant(s) (if known)__________________________________________________________________ 
______________________________________________________________________________________

Decontamination procedure(s) used__________________________________________________________

______________________________________________________________________________________

Cleaning verified by_________________________________________ Title___________________________

Date________________________________	

Decontamination & Cleaning Statement
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2  System Components
Body

The completely sealed Level TROLL contains pressure and temperature 
sensors, real-time clock, microprocessor, sealed lithium battery, data 
logger, and memory. Options include a vented or non-vented pressure 
sensor in a variety of ranges. 

Cable 

Several basic cable types are used in the Level TROLL system.

•	 RuggedCable® System, TPU-jacketed (Thermoplastic Polyurethane)

•	 Vented or non-vented
•	 Vented Tefzel®-jacketed cable (ETFE fluoropolymer)

•	 Poly-coated stainless steel suspension wire for deployment of a non-
vented instrument

•	 Communication cables for programming the device/downloading the 
logged data

TIP: Cable 
markings include 
VF = vent-free

There are no user-
serviceable parts 
in the Level 
TROLL 
Instrument.
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RuggedCable® System

Cable includes conductors for power and communication signals, a 
weight-bearing structure, and a Kellems® grip to anchor the Level 
TROLL securely. Available in standard and custom lengths. 

Uphole and downhole ends are identical “female” twist-lock 
connectors that connect to the Level TROLL Instrument, TROLL 
Com communication cable, desiccants, and other accessories. 

Vented cable is designed for use with vented pressure/level 
sensors (gauged measurements). The cable vent tube insures 
that atmospheric pressure is the reference pressure applied to the 
sensor diaphragm. Vented cable includes a small desiccant cap.

Vented cable is shipped with a small desiccant 
cap that should be replaced with a larger-volume 
desiccant before you deploy the instrument in a 
humid environment.

Non-vented cable may be used with non-vented pressure/level 
sensors (absolute measurements).

Section 2: System Components



16

Level TROLL Operator’s Manual 0052210  rev. 007

RuggedCable “Stripped & Tinned” Systems 

In place of the “uphole” twist-lock connector, this cable ends in 
bare conductors for wiring to a logger or controller using SDI-
12, analog (4-20 mA), or Modbus communication protocols. 
Vented cable includes an outboard desiccant to protect 
against condensation. 

Also available in a shorter length ending in 
a “male” twist-lock connector to mate with 
RuggedCable.

For connections, refer to wiring diagrams in  
Section 8.

Suspension Wire

Poly-coated stainless steel suspension cable is ideal 
for deployment of instruments with non-vented pressure 
sensors: Level TROLL 300, non-vented Level TROLL 
500 or 700, and BaroTROLL.

Section 2: System Components

to Level 
TROLL

to PLC 
or logger

to Level 
TROLL

to RuggedCable

to PLC 
or logger



17

Level TROLL Operator’s Manual 0052210  rev. 007

Small Desiccant 

Vented cable includes a clear cap of indicating silica gel 
desiccant to protect the cable and electronics from condensation 
during shipping. In humid environments, replace the small 
desiccant with a larger-volume desiccant pack before deploying 
the instrument.

Large Desiccant

The optional high-volume desiccant pack attaches to vented cable 
in the same way. Refill kits are also available from In-Situ Inc. or 
your distributor.

Outboard Desiccant

Vented “stripped & tinned” cable includes an outboard 
desiccant pack attached to the cable vent tube. Same size as 
large desiccant. Replacements and refills are available.

Accessory	
Catalog No.
Small desiccant (3)........................................................................ 0052230
Large desiccant, ABS connector................................................... 0053550
Large desiccant, titanium connector.............................................. 0051810
Outboard desiccant (replacement)................................................ 0051380
Refill kit for large & outboard desiccant......................................... 0029140

Section 2: System Components

TIP: Protect new 
desiccant from 
moisture until 
ready to use.
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Section 2: System Components

Communication Cables

TROLL Coms interface between a Level TROLL and a desktop/laptop PC 
or handheld PDA for profiling, calibrating, programming, and downloading. 
Both include 0.9 m (3 ft) vented polyurethane cable, external power input 
jack, and vent with replaceable membrane.

TROLL Com (Cable Connect)

Connects a Level TROLL’s RuggedCable 
to a serial or USB port. Weatherproof, 
withstands a temporary immersion (IP67).

TROLL Com (Direct Connect)

Connects a Level TROLL directly to 
a serial or USB port. A good choice 
for permanent connection to a PC, or 
for programming a non-vented Level 
TROLL that will be deployed without 
RuggedCable. Not submersible.  

Accessory	 Catalog No.
RS232 TROLL Com, Cable Connect............................................. 0056140
USB TROLL Com, Cable Connect................................................ 0052500
RS232 TROLL Com, Direct Connect............................................. 0056150
USB TROLL Com, Direct Connect................................................ 0052510

The computer 
connectors are  
not submersible.

External 
power input

Vent

RS232  
or USB 
connector

Twist-Lock 
connector

Snap-on 
connector

RS232  
or USB 
connector

External 
power input

Vent
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Power Components
Internal Power

The Level TROLL operates on 3.6 VDC, supplied by a completely sealed, 
non-replaceable AA lithium battery. Battery life depends on sampling 
speed. The battery typically lasts for 10 years or 2,000,000 readings, 
whichever occurs first.

External Power

External Battery Pack 

The sealed, submersible TROLL Battery Pack (lithium) supplies 
14.4 V. When this power source is connected, the Level TROLL 
will use the external battery source first and switch to the internal 
batteries when external battery power is depleted. Battery life 
depends on sampling speed.

	 0.5 sec sampling interval 		  1.2 months 
	 1 sec sampling interval 		  2.3 months 
	 1 min sampling interval or longer	 1 year	

AC Adapter

In-Situ’s AC adapter provides 24 VDC, 0.75 A, AC input 100-250 V, 
includes North American power cord. The Programming Cable includes an 
external power input for connection to this adapter.

Accessory	 Catalog No.
External Battery Pack.................................................................... 0051450
AC Adapter 24V............................................................................. 0052440

Section 2: System Components

TIP: Win-Situ 5 
can display the 
approximate 

percentage of internal 
battery life remaining 
when the Level TROLL is 
connected to a computer. 

TIP: When a 
Level TROLL 
is used as an 

Analog (4-20 mA), SDI-12, 
or Modbus device, power is 
supplied by the data logger 
or controller to which the 
Level TROLL is wired. 

Use only 
In-Situ’s 
AC adapter. 

Damage to the Level 
TROLL caused by the use 
of third-party converters 
is not covered by the 
warranty.
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Installation Accessories

•	 1/4” NPT Adapter: allows Level TROLL installation in piping
•	 Twist-lock Hanger: titanium or stainless steel hanger to suspend a 

non-vented Level TROLL or BaroTROLL while taking data; no venting, 
no communication capabilities

•	 Cable Extender: connects two lengths of RuggedCable 
•	 Well Docks: top-of-well support for 2”, 4”, or 6” well
•	 Well caps, locking and vented 
•	 Panel-mounted bulkhead for connection to RuggedCable

Accessory	 Catalog No.
NPT Adapter.................................................................................. 0051470
Twist-Lock Hanger, titanium for Level TROLL 500, 700, Baro....... 0051480
Twist-Lock Hanger, stainless steel for Level TROLL 300.............. 0055050
Cable Extender.............................................................................. 0051490
Top-of-well installation ring........................................ WELLDOCK2”, 4”, 6”
Locking Well cap, 2” ..................................................................... 0020360
Locking Well cap, 2” vented ......................................................... 0020370
Locking Well cap, 4” ..................................................................... 0020380
Locking Well cap, 4” vented ......................................................... 0020390
Bulkhead connector....................................................................... 0053240

Section 2: System Components

NPT Adapter

Twist-Lock Hanger

Cable Extender

Locking Well cap

Well Dock

Bulkhead connector
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Control Software

Win-Situ® 5 Software is easy-to-use software for programming the Level 
TROLL Instrument. 

Win-Situ 5 Software provides instrument control for direct reads and 
profiling, long-term data logging, data downloads, data viewing, data 
export to popular spreadsheet programs, choice of units, display options, 
and battery/memory usage tracking. Win-Situ® Plus enables configuration 
of networks and telemetry. 

Minimum system requirements: 400 MHz Pentium® II processor, 128 Mb 
RAM, 100 Mb free disk space, Internet Explorer® 6.01 or higher, Windows® 
2000 Professional SP4 or higher, or Windows XP Professional SP2 or 
higher, or Windows Vista SP1 or higher, CD-ROM drive, and a serial 
communications port.

Win-Situ® Mobile provides the features and functions of Win-Situ 5 on 
a field-portable platform. Requirements: In-Situ RuggedReader® with 
Microsoft Windows Mobile® operating system Windows Mobile 5 or later, 
serial communications port, and at least 16 Mb for data storage (SD card, 
CF card, or the device’s built-in non-volatile memory). For installation and 
file exchange, Windows 7 requires Windows Mobile Device Center to be 
installed on the computer. Earlier versions on Windows require Microsoft® 
ActiveSync®.

Accessory	 Catalog No.
Win-Situ 5 (no license required).................................................... 0051980
Win-Situ Mobile license for RuggedReader................................... 0047520
Win-Situ Mobile license (upgrade from Pocket-Situ 4).................. 0047550

Section 2: System Components
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Section 2: System Components

Product Specifications
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Product Specifications Continued
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Section 2: System Components

Cable
Jacket options	 Polyurethane, Tefzel®

Connector	 Titanium, 18.5 mm (0.73 in) O.D.
Conductors	 6 conductors, 24 AWG, polypropylene insulation
Diameter	 6.7 mm (0.265 in)
Break strength	 127 kg (280 lb)
Minimum bend radius	 2X cable diameter (13.5 mm, 0.54 in)
     (vented cable)	
Weight	 Vented: 14 kg/300 m (32 lb/1000 ft)  

Non-vented: 16 kg/300 m (35.6 lb/1000 ft) 
Vented Tefzel: 14 kg/300 m (32 lb/1000 ft)]

Suspension Wire
Material	 304 stainless steel, 7 x 7 strand
Coating 	 15 mil polyester elastomer insulation
Weight	 0.28 kg /30 m (0.60 lb/100 ft)
Break strength	 122 kg (270 lb) with proper tightening of clips 
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3  Getting Started

This section provides a quick overview of the initial steps necessary to get 
the instrument ready to log data.

4	Select the appropriate TROLL Com for communication. This 
determines the hardware connections, and may influence the software 
installation. The drawing on the following page shows the function of 
the different TROLL Com models.

4	 Install the software.

4	Connect the hardware, based on the selected TROLL Com.

4	Open the software and establish communication with the Level 
TROLL. See Section 4 of this manual for an overview of Win-Situ 
operations.
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Select a TROLL Com for Communication

The figure below shows the function and connectability of the different 
models of TROLL Com.

Section 3: Getting Started

R

Serial port

RS232  
connections

USB port

USB  
connections

Direct Connect 
TROLL Coms: 
Not designed 

for submersion

Cable Connect TROLL Coms: 
Designed for field use

TIPS: A Direct 
Connect TROLL 
Com may be 

preferred for programming 
a Level TROLL that will be 
deployed on wire.

RuggedCable and a Cable 
Connect TROLL Com are 
required for communication 
with the device while 
deployed, but programming 
can be done with any 
TROLL Com connection.

An RS232 (serial) TROLL 
Com is needed for use with 
a RuggedReader. 
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Install the Software

Win-Situ 5

Install Win-Situ 5 from the In-Situ software/resource CD or from the In-Situ 
web site: 

•	 Click on Win-Situ 5, and follow the instructions to install Win-Situ 5 to 
your local hard drive. 

USB TROLL Com Drivers
•	 If using a USB TROLL Com, be sure to select the option "Install USB 

TROLL Com Drivers." Two drivers will be loaded to your hard drive, 
one for the USB TROLL Com, one for the USB TROLL Com serial 
port.

Win-Situ Mobile

For communication using a RuggedReader Handheld PC in the field, 
install the desktop component of Win-Situ Mobile on a desktop/laptop 
PC from the CD or web site: The desktop component is called the Win-
Situ Software Manager, and is needed to install Win-Situ Mobile on the 
RuggedReader.

•	 Click on Win-Situ Mobile and follow the instructions to install the Win-
Situ Software Manager to your local hard drive. 

When convenient, connect the RuggedReader to the PC, establish 
a connection in Microsoft ActiveSync®, launch the Win-Situ Software 
Manager, and follow the instructions to install Win-Situ Mobile on the 
RuggedReader.

Win-Situ Sync

If you plan to synchronize log files from the RuggedReader to a PC after 
collecting data in the field, install Win-Situ Sync from the CD or website.

TIP: If using a 
USB TROLL 
Com, be sure  

to select the option “Install 
USB TROLL Com Drivers” 
when installing Win-Situ 5. 

TIP: If using 
Windows 7, 
ensure that 

Windows Mobile Device 
Center is installed. If using 
an operating system prior 
to Windows 7, ensure that 
Microsoft ActiveSync is 
installed on the desktop 
or laptop PC and a Guest 
connection or partnership 
has been established 
between the computers.

Section 3: Getting Started
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Connect the Hardware

1.	 Connect the instrument to the selected TROLL Com as illustrated 
earlier in this section.

•	 Direct Connect: Attach via snap-on connection to the back end of 
the instrument.

•	 Cable Connect: Attach the twist-lock connectors on the 
instrument and the RuggedCable.

2.	 Plug the TROLL Com into the computer.

USB TROLL Com

When you plug in a USB TROLL Com, the USB drivers that were 
downloaded when you installed Win-Situ 5 will be installed.

After installation, check as follows to find the COM port the connected 
USB TROLL Com is using:

Windows 2000, Windows XP: Control Panel > System > Hardware •	
tab > Device Manager > Ports. Click the plus sign to display the 
ports.

Windows Vista and 7: Control Panel > System > Device Manager •	
(Administrator permission required) > Ports. Click the plus sign to 
display the ports.

After connections are made, you are ready to open the software and 
program the instrument. Section 4 of this manual is an overview of Win-
Situ. For more detailed information, see Win-Situ’s Help menu.

Section 3: Getting Started

TIP: If you need 
more information 
on the twist-lock 

connectors, refer to the 
topic Twist-Lock Cable 
Connections later in this 
section. 

Remember 
the COM port 
number. You will 

need it when connecting 
to the Level TROLL in 
Win-Situ. 
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Section 3: Getting Started

Twist-Lock Cable Connections

1.	 Remove the protective caps from the Level TROLL and cable. 

2.	 Each connector has a flat side. 

	 Note the pins on the instrument connector (one on each side) and the 
slots on the cable connector (one on each side).

TIP: Retain the 
dust caps to 
protect the pins 

and O-ring from damage 
when cable is not attached.

pin slot

Flat Flat

Level TROLL
(or TROLL 
Com)

Cable

Level TROLL
(or TROLL Com)

Cable
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3.	 Slide back the sleeve on the cable connector. 

4.	 Position the flat edges so they will connect properly, and insert the 
Level TROLL connector firmly into the cable connector.

5.	 Slide the sleeve on the cable toward the Level TROLL Instrument 
until the pin on the instrument fits into the round hole in the slot on the 
cable connector. 

Section 3: Getting Started

Level TROLL Cable

Level TROLL Cable
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Section 3: Getting Started

6.	 Grasp the textured section of the cable connector in one hand and 
the Level TROLL Instrument in the other. Push and twist firmly so that 
the pin on the instrument connector slides along the slot on the cable 
connector and locks securely into the other hole. 

7.	 To attach a Cable Connect TROLL Com, first remove the desiccant 
from the cable: Grasp the textured section of the cable connector in 
one hand and the desiccant in the other. Twist in opposite directions to 
unlock the desiccant from the cable.

8.	 Positin the flat edges so they will connect properly, and insert the 
TROLL Com connector firmly into the cable connector.

9.	 Push, twist, and click to lock. 

Be sure you 
hear the “click.” 
The “click” 

ensures the cable is 
securely attached. 

Level TROLL Cable

Remember to 
re-install the 
desiccant before 

deploying the device.  
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Win-Situ 5 Software is In-Situ’s instrument control software for Level 
TROLLs. Use Win-Situ software to:

•	 Display real-time readings from the connected Level TROLL, in 
meter, tabular, or graphic format

•	 Program the device to log data; download the logged data

•	 Customize the output of a pressure/level sensor to record 
drawdown, surface water elevation, gauge height, stage height, 
etc.

•	 Set communication options in the device—Modbus, SDI-12, 
analog, IP, telemetry, etc.

Launch the Software and Connect to the Level 
TROLL

1.	 Start Win-Situ by double-clicking the shortcut  created on the 
desktop during installation. 

4  Using Win-Situ® 5 
Software

TIP: Win-Situ® 
Mobile software 
provides 

Win-Situ’s features and 
functionality in a convenient 
field-worthy platform.
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Section 4: Using Win-Situ

TIP: You can turn 
off the “Connect 
now?” prompt:  

Select Preferences menu > 
General Settings, deselect 
“Prompt for connect at 
startup,” click OK. In this 
case, connect to the device 
by clicking the Connect 
button  .

	 Win-Situ opens and displays the Data area (“tab”) shown below.

2.	 Check the COM port. The software may ask if you want to select a 
COM port. Do one of the following:

 Answer Yes to the prompt, then check or change the port in the 
Comm Settings dialog, and click OK  to close it, or

 Answer No to bypass this step.

3.	 Win-Situ asks if you want to connect to the Level TROLL (the 
“device”). If the Level TROLL is connected to your computer as 
described in the previous section, answer Yes. 

Connect  
button

2

3

Data tab

C:\Documents and Settings\ [Login] \My Documents\WinSitu Data

TIP: For direct 
serial connection 
the port is usually 

COM 1. This is Win-Situ’s 
default.

For USB communication, 
be sure to select the correct 
COM port.
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4.	 Software connects and displays a reading of all supported 
parameters.

The Home Screen

	 Note the Tabs at the top of the screen— this is the Home tab, which 
displays current readings from the connected device. 

	 The Dashboard (status area) shows device model and serial number, 
battery and memory usage, clock, alarms, and logging status. 

	 The Control Panel contains action buttons. To update the readings in 
real time press .

	 Note: When this button looks “pressed in” , polling is active. 
Before you can perform certain software tasks, you will need to stop 
polling by pressing the button again.

Section 4: Using Win-Situ

Tabs

Dashboard

Device is connected 

Control Panel

Click here to update 
readings in real time

Home tab
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Customizing the Home Screen Display

Changing Units

1.	 Click the Senors tab , select the level/pressure sensor.

2.	 Click the Configure button  in the 
control panel.

3.	 In the Sensor Setup screen, select a 
parameter, then select a unit. Repeat for 
each parameter as necessary. 

4.	 Click OK  to change the units and 
return to the Sensors tab.

Changing the Rate at Which the Readings Update

Also called the “poll rate,” this can range from 1 to 30 seconds.

1.	 Select Preferences menu > Home View Settings.

2.	 Adjust the Poll Rate. Default: 5 seconds.

Changing the Decimal Places Displayed 

To change the number of decimal places displayed for each reading:

1.	 Select Preferences menu > General Settings.

2.	 Under Parameter Defaults, select a parameter, then the significant 
decimal digits for each parameter. 

Real-Time Graphing
To view a real-time trend graph: click the graph button 

To view a graph with a data table below it, select Preferences menu > 
Graph Settings. Check    the Data Panel option. Click OK.

Section 4: Using Win-Situ
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Now you’re ready to give the Level TROLL some specific information 
through the software. Win-Situ provides many options. At a minimum: 
•	 set the Level TROLL clock
•	 enter a name for the site where the Level TROLL will collect data
•	 enter data logging instructions
A brief overview is provided here. For more detailed information, see Win-
Situ’s Help menu.

Set the Clock

Data collection schedules depend on the device’s real-time clock. Both the 
device clock and the system (PC) clock are shown on the dashboard. The 
clocks update every 2 seconds. If the device clock differs by more than 
2 seconds from the system clock, the device clock is displayed in red. To 
synchronize the clocks, click the Sync button. 

Section 4: Using Win-Situ

Clock Sync 
button

Device clock

PC clock
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Add a Site

Logged data are organized and filed by the site where the data were 
logged. This feature can help you manage data from multiple sites. You 
can create as many sites as you like, with or without a Level TROLL 
connected. Sites are stored in the site database in your Win-Situ working 
directory and are available to select for any Level TROLL, any log. 

You will need a site when setting up a data log. To set up a new site:

1.	 Do one of the following: 

•	 With a device connected: On the Home tab, click the Site button 
on the dashboard. When the Site List is displayed, click the “New” 

 button. 

•	 With or without a device connected: On the Data tab, click the Site 
Data folder, select File menu > New > Site.

Section 4: Using Win-Situ

Home tab

Site button

Data tab
Site Data folder

C:\Documents and Settings\ [Login] \My Documents\WinSitu Data\Site Data

TIP: A default site 
is supplied and 
may be used, but it 

does not contain any 
specific information on the 
location where the Aqua 
TROLL collected data. For 
more information on sites, 
see Win-Situ’s online Help. 
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TIP: The site 
coordinates 
are optional. 

They are used to uniquely 
identify a data site. They 
are not used elsewhere by 
the software.

2.	 In the next screen, enter a short—up to 32 characters—descriptive site 
name, such as a project, well, water body, gauging station, town, etc. 

	 A name the only required field, but there are many additional 
options for identifying a site. To include site Coordinates, check  
Coordinates, then enter Latitude (0.00 to 90.00, North or South), 
Longitude (0.00 to 180.00, East or West), and Elevation (Feet or 
Meters). You can import a site Photo (bitmap) and/or select a custom 
Connection, if any have been defined.

3.	 When finished, click Save or click OK twice  to save the site. 

Section 4: Using Win-Situ

Name the site

Save the site
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Select the new site

4.	 In the Home tab, click the down arrow beside the site box, and select 
your new site. 

	 This site now becomes the “current” site for the connected Level 
TROLL, and is available to use in data logs.

Section 4: Using Win-Situ
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Logging tab

“New” button

TIP: For more 
complete 
information on 

setting up data logs, see 
Win-Situ’s Help menu. 

Prepare to Log Data

1.	 To program the device to log data, first select the Logging tab.

2.	 Click the “New” button. 

The Logging Setup Wizard will prompt you through the configuration of a 
data log—including the site, log name, parameters to measure, sample 
schedule, start time, stop time, output (depth or level), and other options. 
For details on setting the pressure sensor output, refer to Win-Situ’s Help 
menu, or Section 5 in this manual.

Section 4: Using Win-Situ

TIP: For a Level 
TROLL 300 or 
other non-vented 

Level TROLL that will be 
deployed on wire, be sure 
to select a Scheduled Start 
so the log will start by itself, 
without a communication 
connection. 
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TIP: As an 
alternative to 
the log control 

buttons, right-click a log 
to display a short context 
menu of available actions.

Log control buttons

Logging tab
“Ready” log

“Start” button

Section 4: Using Win-Situ

To Start logging: 

	 A “Pending” (scheduled) log will start at its programmed time
	 You can start a “Ready” (manual) log at any time  

while connected by selecting the log and pressing “Start”  

To Stop logging: 

	 Select the log and press the “Stop” button 
	 Or suspend (temporarily stop) it with the “Pause” button  

To Download the log to the connected PC: 

	 Select the log and press the “Download” button 

To View the log after downloading:

	 Go to the Data tab and select the log; for a graph press 

TIP: The 
available log 
control buttons 

will vary depending on 
the status of the log 
selected.
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Section 4: Using Win-Situ

Disconnect

After the Level TROLL is programmed to log data, you’re ready to:

•	 Exit the software (File menu > Exit).

•	 Disconnect the TROLL Com from the cable connector, by grasping 
the knurled (textured) section of the cable connector in one hand and 
the TROLL Com in the other. Twist in opposite directions to unlock the 
TROLL Com from the cable. 

•	 Vented cable: Attach desiccant to the cable connector—line up the flat 
sides of the connectors, push, twist, and click to lock the desiccant to 
the cable. Remove red dust cap (if present) from the desiccant’s vent.

•	 Non-vented Level TROLL or BaroTROLL: Attach a Twist-Lock hanger 
to prevent flooding, and suspension wire (if using).

•	 Install the instrument in its field location. See Section 6 for guidelines.

Remove the 
desiccant dust 
cap (if present) 

before deployment to allow 
air to reach the cable’s 
vent tube.
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5  About the Pressure/ 
Level Sensor

A pressure transducer senses changes in pressure, measured in force per 
square unit of surface area, exerted by water or other fluid on an internal 
media-isolated strain gauge. Common measurement units are pounds per 
square inch (PSI) or newtons per square meter (pascals).

Non-Vented (Absolute) vs. Vented (Gauged) 
Sensors

A non-vented or “absolute” pressure sensor measures all pressure forces 
exerted on the strain gauge, including atmospheric pressure. Its units are 
PSIA (pounds per square inch “absolute”), measured with respect to zero 
pressure. 

Non-vented pressure measurements are useful in vacuum testing, in 
short-term testing when atmospheric pressure would not be expected 
to change, in very deep aquifers where the effects of atmospheric 
pressure are negligible, and in unconfined aquifers that are open to the 
atmosphere.
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With vented or “gauged” pressure sensors, a vent tube in the cable 
applies atmospheric pressure to the back of the strain gauge. The basic 
unit for vented measurements is PSIG (pounds per square inch “gauge”), 
measured with respect to atmospheric pressure. Vented sensors thus 
exclude the atmospheric or barometric pressure component. 

This difference between absolute and gauged measurements may be 
represented by a simple equation:

Pgauge = Pabsolute - Patmosphere

Pressure, Depth, and Level

Output options for pressure measurement are completely software-
selectable. Each log configuration presents the following choices:

•	 Pressure in PSI or kPa
•	 Depth in feet or meters
•	 Water Level with a reference (an “offset”)

	 Surface Elevation reference: positive up

	 Depth to Water (drawdown) reference: positive down

Pressure is a simple check box. For depth or level, the software presents 
additional options:

•	 The type of Level measurement you intend to log (the 
“output”)

•	 The Level Reference you wish to use

•	 The type of water you will be monitoring in (fresh, brackish, 
or saline). Or choose the Advanced button for a pressure-to-
level conversion that compensates pressure readings for fluid 
density, latitude, and elevation

Section 5: Pressure/Level

TIP: For more on 
the differences 
between 

Absolute (non-vented) and 
Gauged (vented) sensors, 
see the technical note 
on the In-Situ software/
resource CD, or the 
Downloads section of the 
In-Situ web site at www.
In-Situ.com.
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Section 5: Pressure/Level

Configuring Depth and Level

This procedure stores the configuration settings in the Level TROLL. 
When setting up a log, the same options are presented.

1.	 While connected to the Level TROLL in software, click the Sensors 
tab.

2.	 Select the level/pressure sensor and click the “Configure” button 
. (Not available for a BaroTROLL.)

TIP: When 
you configure 
level using the 

Sensors tab, the settings 
are stored in the Level 
TROLL and are available 
for use in Modbus, 
SDI-12, and analog 
communications, as well 
as in Win-Situ. Different 
configuration may be 
selected when setting up 
a log.

Sensors tab

“Configure” button

Level/pressure sensor
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Section 5: Pressure/Level

TIP: The 
Level TROLL 
measures three 

parameters—Pressure, 
Temperature, and 
Level—on one sensor. 
A BaroTROLL does not 
measure Level, so the 
Configure option is not 
available.

3.	 In the Sensor Setup window, select the Level parameter, then click 
Configure... 

	 The Level parameter shown is the one currently stored in the device 
(device’s default or the most recent choice). You will have a chance to 
change this in a moment.

Select the 
Level  
parameter

Click  
Configure...



47

Level TROLL Operator’s Manual 0052210  rev. 007

4.	 In the Level Setup Wizard, select the options you want. Each choice 
includes an illustration. For more information, see Help in Win-Situ 5 
Software.

Section 5: Pressure/Level
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Section 5: Pressure/Level

Pressure Sensor Calibration 

Factory Recalibration

Pressure sensor accuracy can be adversely affected by improper care 
and handling, lightning strikes and similar surges, exceeding operating 
temperature and pressure limits, physical damage or abuse, as well as 
normal drift in the device’s electronic components. Aside from damage 
to the sensor, the need for factory recalibration is dependent upon the 
amount of drift a customer is willing to tolerate. Factory calibration every 
12-18 months is recommended. Contact In-Situ Customer Service for 
information on the factory maintenance and calibration plan. 

Field Recalibration

The following procedure may be used, with caution, to “zero” the offset of 
a vented pressure sensor to correct for electronic drift. The drifted offset is 
visible when the sensor is in air and reading other than zero. 

It is recommended you do not set to zero the offset if it is outside the 
specified accuracy of your pressure sensor, as shown in the table below. 
If the reading in air deviates from zero by more than the amounts shown, 
you may want to consider a factory recalibration. 

Sensor	 Accuracy	 Acceptable Offset 
range	 (-5°C to +50°C)	      from zero

  5 PSI	 ± 0.1% FS	 ± 0.005 PSI 
15 PSI	 ± 0.1% FS	 ± 0.015 PSI 
30 PSI	 ± 0.1% FS	 ± 0.03 PSI 
100 PSI	 ± 0.1% FS	 ± 0.10 PSI 
300 PSI	 ± 0.1% FS	 ± 0.30 PSI 
500 PSI	 ± 0.1% FS	 ± 0.50 PSI

TIP: Field 
recalibration is 
not available for 
a BaroTROLL. 
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Section 5: Pressure/Level

Field Recalibration Procedure for a Vented Sensor

1.	 With the Level TROLL connected in software, select the Sensors tab. 

2.	 Select the pressure sensor and click the Calibrate button. 

	 You will be prompted to ensure the device is in air.

3.	 With the device in air, click Calibrate.

The current pressure reading will be set to zero. 

Sensors tab

“Calibrate” button

Select the sensor
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Section 5: Pressure/Level

Barometric Compensation of Non-Vented 
Pressure/Level Data using Baro Merge™

Win-Situ® Baro Merge™ can post-correct absolute (non-vented) level 
sensor data to eliminate barometric pressure from the measurements. 
Or it can be used with gauged (vented) level sensor data to calculate 
barometric efficiency. 

Baro Merge provides 3 options:

•	 Fixed Correction – A single offset value is applied to all selected log 
data. Use this option if you know what the barometric pressure was 
during the log, and it did not change.

•	 Manual Entry – Specify 2 or more correction values to apply to the log 
data. Use this option if you know that barometric pressure changed 
during the log.

•	 BaroTROLL log file – Absolute level sensor data are corrected by 
barometric pressure values logged by an In-Situ BaroTROLL during the 
same general time period.

Launching Baro Merge

Baro Merge may be opened as a stand-alone application from the 
program group In-Situ Inc., or accessed from Win-Situ’s Tools menu when 
both are installed on the same system.

Input

In the Fixed Correction and Manual Entry options, it is important to know 
the barometric pressure for the general time period covered by the log or 
logs you want to correct. 

Baro Merge uses a Wizard-like interface consisting of three main steps:
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1.	 Select the type of compensation/correction you intend to use.

2.	 Select the absolute (non-vented) log file or files you intend to correct. 
Baro Merge displays these automatically.

3.	 Click OK and the barometric compensation is applied.

Output

Your original log file is not changed.  A new, corrected log file with the 
same name and path is created. The original “.wsl” extension is replaced 
by “-BaroMerge.wsl”. 

For help on using Win-Situ Baro Merge, press F1 at any Baro Merge 
screen.

For more detailed information on barometric compensation see the 
technical notes on the In-Situ software/resource CD, or the Downloads 
section of the In-Situ web site at www.In-Situ.com.

Section 5: Pressure/Level
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6  Field Installation

Position the Level TROLL

Lower the Level TROLL gently to approximately the desired depth. 
Position the instrument below the lowest anticipated water level, but not 
so low that its range might be exceeded at the highest anticipated level. 
Refer to the tables below for usable depth.

Note that a BaroTROLL is not designed for submersion. Position it above 
water level near a submerged Level TROLL.

Non-Vented Level TROLL
Range Effective Range Usable Depth
PSIA PSIA kPa Meters Feet

30 15.5 106.9 0–10.9 0–35.8
100 85.5 589.5 0–60.1 0–197.3
300 285.5 1968 0–200.7 0–658.7
500 485.5 3347 0–341.3 0–1120

1000 985.5 6795 692.9 0–2273
* At sea level (14.5 PSI atmospheric pressure).

Vented Level TROLL
Range Usable Depth

PSIG kPa Meters Feet
5 34.5 0–3.5 0–11.5

15 103.4 0–11 0–35
30 206.8 0–21 0–69

100 689.5 0–70 0–231
300 2068 0–210 0–692
500 3447 0–351 0–1153
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Check the Instrument’s Depth

At this point, if convenient, you can connect the Level TROLL to a 
PC, launch the software, and take a reading. If the instrument is at 
the desired depth, secure it in position as suggested below. If not, 
reposition the Level TROLL as necessary.

If you requested the software to “Remind me later” to set a Level 
Reference, enter the level reference after installation when 
prompted.

Secure the Cable

The RuggedCable includes a Kellems® grip near the surface 
end. You can slide it along the cable to the desired position by 
compressing it. When you pull on it, it tightens and stops sliding. 
You may need to pull on both ends of the Kellems grip to properly 
tighten it and keep it from slipping.

Use the loop of the Kellems grip to anchor the cable to a 
convenient stationary object. It works well with In-Situ’s “well dock” 
installation ring. Simply insert the loop into the locking clip on the 
well dock, and position the assembly on the top of a well.

Installation Tips

	 Never let a probe “free fall” down a well. The resulting shock 
wave when it hits the water surface can damage the strain 
gauge. 

	 Check the level of water above the probe, then move it and 
read again to be sure that the probe is giving a reasonable 
reading and showing change. It might not be located where 

Section 6: Field Installation

Kellems grip
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you think it is — for example, it could be wedged against the casing 
with a loop of cable hanging below it. A probe in such a position might 
become dislodged and move while logging, giving a false change in 
level. A secure placement is critical to accurate measurements. 

	 Do not allow the vented cable to kink or bend. If the internal vent tube 
is obstructed, water level measurements can be adversely affected. 
The recommended minimum bend radius is 13.5 mm (0.54 in), which 
is twice the cable diameter.

	 For accurate measurements, the instrument should remain immobile 
while logging data. 

	 Be sure the uphole cable end is capped—desiccant cap on the vented 
cable connector, soft dust cap on non-vented cable—and positioned above 
the highest anticipated water level. Avoid areas that may flood.

	 Do not deploy pressure transducers in such a way that ice may 
form on or near the sensor or cable connections.  Ice formation is 
a powerful expansive force and may over-pressurize the sensor or 
otherwise cause damage.  Any damage associated with ice formation 
is not covered by the warranty.

Stabilization Time

Allow the Level TROLL to stabilize to the water conditions for about 
an hour before logging data. A generous stabilization time is always 
desirable, especially in long-term deployments. Even though the cable is 
shielded, temperature stabilization, and stretching can cause apparent 
changes in the probe reading. If you expect to monitor water levels at the 
highest accuracy achievable by the probe allow stabilization time.

Section 6: Field Installation

The minimum 
bend radius for 
vented cable is 

13.5 mm (0.54 in).

Do not 
submerge the 
connector at the 

uphole end of the cable.

TIP: Be sure 
to replace the 
desiccant before 

it appears pink. Expired 
desiccant can allow 
water build up in the vent 
tube, causing a blockage 
resulting in inaccurate data.
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Installation of a Level TROLL 300 or Other 
Non-Vented Level TROLL

All Level TROLL 300 and non-vented Level TROLL 500 and 700 
instruments  include non-vented (absolute, PSIA) pressure sensors and 
do not require vented cable for proper operation. They may be 
deployed on non-vented RuggedCable or with a twist-lock hanger 
and stainless steel suspension wire while logging data. 

•	 Because the twist-lock hanger has no communication 
capabilities, program the Level TROLL in advance, and 
download the data the same way.

•	 Logged pressure data will show the effects of changes in 
barometric pressure (unlike vented Level TROLLs). However, 
post-processing tools such as Win-Situ Baro Merge may be 
used to eliminate the effects of barometric pressure changes 
from the data, if required.

Section 6: Field Installation

TIP: Be sure 
to program a 
non-vented Level 

TROLL or BaroTROLL 
before attaching the 
twist-lock hanger, as 
this accessory has no 
communication capability.

DO NOT 
submerge a 
non-vented 

Level TROLL 500 or 700 
without first attaching a 
twist-lock hanger, or a 
cable, as the unit could be 
damaged by flooding.

Although the Level TROLL 
300 is completely sealed 
from flooding, a hanger is 
recommended.
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TIP: For 
more detailed 
information on 

barometric compensation 
see the technical notes 
on the In-Situ software/
resource CD, or the 
Downloads section of the 
In-Situ website at www.
In-Situ.com.

7  BaroTROLL
In-Situ’s BaroTROLL® is a special model of non-vented Level 
TROLL designed to log barometric pressure from 0 to 16.5 
PSIA (1.14 bar, 33.59 in Hg) at the surface near a submerged 
non-vented Level TROLL. BaroTROLL data may then be 
used to correct the Level TROLL data for barometric pressure 
fluctuations. 

Programming

•	 Program before installation. Be sure to sync the clock.

•	 Schedule a log with the same start time as that in the paired 
non-vented Level TROLL. Select the same sample interval.

Installation

After programming, install the BaroTROLL in a protected location 
above water level. Install the BaroTROLL near the submerged 
non-vented unit. One possibility is shown below, using a twist-
lock hanger and suspension wire.

•	 Be sure to attach the twist-lock hanger before installation to prevent 
flooding.
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Section 7: BaroTROLL

Water 
Level

Non-vented 
Level TROLL

Pressure  
due to  
water column 
(measured by 
vented sensor,  
or by  
subtracting 
BaroTROLL 
data from  
non-vented 
sensor data)

Pressure 
due to  

atmosphere + 
water column 
(measured by 

non-vented 
sensor)

BaroTROLL

Pressure  
due to  
atmosphere 
(measured by 
BaroTROLL )
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8  Analog, SDI-12 & 
Modbus connections

The Level TROLL may be connected to a controller or logger for 
communication via:

•	 Analog (4-20 mA) 
•	 SDI-12
•	 RS485 Modbus
•	 RS232 Modbus (with a customer-supplied converter)

RuggedCable Stripped & Tinned has a female twist-lock connector on 
one end to connect with the Level TROLL Instrument. The uphole end 
terminates in bare wires for connection to a PLC or data logger. 

Also available in a shorter length ending in a male twist-lock connector to 
connect with RuggedCable Systems.
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Section 8: Analog, SDI-12, Modbus

Stripped & Tinned Cable 
with “female” connector

Level TROLL

PLC or Logger

Level TROLL

Short Stripped & Tinned Cable 
with “male” connector

RuggedCable

PLC or Logger
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Section 8: Analog, SDI-12, Modbus

and secured 
to cable with 
strap

Outboard desiccant 
is attached to cable 
vent tube

Desiccant

Vented cable must be installed with 
outboard desiccant to protect the cable 
vent tube and Level TROLL electronics 
from condensation in high-humidity 
environments.

The desiccant may be removed from the 
vent tube, if needed, to trim the conductor 
wires. Pull the vent tube extender off 
the cable vent tube to remove, replace 
desiccant after trimming and connecting 
wires.

Wiring

Refer to diagrams on the following pages. Trim back and insulate unused 
wires. The shield should be wired to a chassis ground or earth ground.

RuggedCable
Signal	 Color	 Pin

Gnd/Return	 BLACK	 6 
Ext Power	 RED	 5 
4-20 mA	 BROWN	 4 
RS485(–)	 GREEN	 3 
RS485(+)	 BLUE	 2 
SDI-12	 WHITE	 1

m2
m1

f5

m3
f6 f4
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Section 8: Analog, SDI-12, Modbus

Analog  (4-20 mA)     2 wire

Level 
TROLL

4-20 ma brown

PLC or Data Logger

gnd/return black

+

- signal

12-36 VDC
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Section 8: Analog, SDI-12, Modbus

SDI-12      3 wire

ext pwr red

gnd/return black

Data Logger

9.6-16 VDC

SDI-12 
sensor

sdi-12 white

rs485 (–) green
rs485 (+) blue

Max. cable length 200 ft
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Section 8: Analog, SDI-12, Modbus

Modbus Master
with RS485 built in

  * Optional but highly recommended

ext pwr red

gnd/return black

Digital PLC

12-36 VDC*

Modbus 
Slave

rs485 (–) green

rs485 (+) blue
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Section 8: Analog, SDI-12, Modbus

R
S4

85

R
S2

32

***Required if port power is not available   	

D
B9

F TD
(A)

TD
(B)

G
N

D
G

N
D

+12V

rs485 (–) green

rs485 (+) blue

pin 5 gnd

pin 3 txd

pin 2 rxd

gnd/return black***

ext pwr red***

Converter
Port-Powered RS485 converter, 
such as B&B Electronics Model 
485SD9TB	

Modbus Master
with RS232 built in (converter required)

  * Voltage limited by converter

ext pwr red

gnd/return black

Digital PLC

12 VDC*

Modbus 
Slave

rs485 (–) green

rs232 (RXD)

rs232 (TXD)

Converter

Gnd   +12V

rs485 (+) blue
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Power Connections
The Red wire provides power for Modbus and SDI-12 modes. The Brown 
wire provides power for the 4-20 mA mode. If power is present on the 
Brown wire and not on the Red wire, the device enters the 4-20 mA mode 
automatically and stays in the 4-20 mode until power is removed from the 
Brown wire or is applied to the Red wire. The Red wire has priority — if 
power is applied to both wires at the same time, the device will operate in 
Modbus or SDI-12 modes but not in 4-20.

Communications
The device automatically switches between Modbus and SDI-12 modes 
depending on which of the two interfaces has activity. Modbus and SDI-12 
cannot be used at the same time — whichever one is currently in use will 
block communication on the other.

Using Win-Situ® 5 Software

Win-Situ provides options for configuring analog/SDI-12 communications 
(Setup tab) and Modbus communications (File menu > Settings). In 
addition, the Level TROLL is capable of internal logging (programmed 
in Win-Situ) while participating in a Modbus, SDI-12 or analog network. 
However, Win-Situ cannot communicate with the Level TROLL while 
it is transmitting Modbus, SDI-12 or analog data, and conversely, the 
instrument cannot receive or respond to Modbus, SDI-12 or analog 
commands while connected to a PC serial port.

This “redundant logging” feature means 

•	 If the PLC or recorder somehow loses data, the Level TROLL data can 
be retrieved using Win-Situ.

Section 8: Analog, SDI-12, Modbus
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Section 8: Analog, SDI-12, Modbus

•	 If the PLC or recorder ceases to function due to power loss, the Level 
TROLL will continue to collect data using its own internal batteries and 
clock. 

A port-powered RS485 converter like that shown for Modbus connections 
may be used for temporary connection of the Level TROLL to a serial port 
on a PC.

For More Information

For additional information on Modbus and SDI-12 communications, 
including the SDI-12 commands and Modbus registers, see these In-Situ 
technical notes: 

SDI-12 Commands and Level TROLL Responses. •	

In-Situ Modbus Communication Protocol. •	

They are available on the In-Situ software/resource CD, and in the 
Downloads section of the In-Situ web site at www.In-Situ.com.
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9  Care & Maintenance
Operating Considerations

The Level TROLL has been designed to withstand harsh field conditions. 
However, as with any electronic instrument, it can be permanently 
damaged if used outside its operating specifications.

Temperature

The Level TROLL and BaroTROLL instruments operate within a 
temperature range of -20°C to +80°C (-4°F to 176°F). 

Pressure Range

The Level TROLL can withstand pressures of up to two times (2X) the 
rated range of the pressure sensor without damage, although it may not 
read correctly at such pressure. If the pressure range is exceeded by 3X, 
the sensor will be destroyed.

Factory Recalibration

Accuracy can be adversely affected by improper care and handling, 
lightning strikes and similar surges, exceeding operating temperature 
and pressure limits, physical damage or abuse. Factory calibration every 
12-18 months is recommended. Contact In-Situ Customer Service for 
information on the factory maintenance and calibration plan. 

Do not deploy 
pressure 
transducers in 

such a way that ice may 
form on or near the sensor 
or cable connections.  Ice 
formation is a powerful 
expansive force and may 
over-pressurize the sensor 
or otherwise cause damage 
that is not covered by the 
warranty.
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When the nose 
cone is 
removed, the 

sensitive pressure sensor 
diaphragm is completely 
exposed. Do not touch this 
area with any object! 
Replace the nose cone as 
soon as possible.

Section 9: Care & Maintenance

Storage

Store the Level TROLL clean and dry. Place the protective red dust cap on 
the cable end, or store with cable attached to protect the connector pins 
and o-ring. 

Store the instrument where it will be safe from mechanical shocks that 
may occur, such as rolling off a bench onto a hard surface. 

Protect the instrument from temperature extremes. Store within a 
temperature range of -40°C to +80°C (-40°F to +176°F).

General Maintenance

Cleaning—Body and Front End

Clean the Level TROLL body with water and a soft brush or plastic 
scouring pad, or soak overnight in a mild acidic solution, such as 
household vinegar.

If the pressure ports in the front end are clogged with silt or mud, try the 
following:

•	 Agitate the instrument vigorously in a bucket of clean water.
•	 Apply a gentle stream of water from a wash bottle.
•	 In severe cases, remove the nose cone and clean out the holes with a 

soft brush or pipe cleaner. 

To avoid damage to the pressure sensor diaphragm, do not insert any 
object into the sensor opening or attempt to dig out dirt or other materials.

If contamination cannot be removed using the recommendations above, 
please contact In-Situ Inc. for cleaning.

Damage caused by digging or scraping in the pressure sensor 
opening to remove silt, mud, etc. is not covered by the warranty.

Nose cone removed

Nose cone in place
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Do not 
submerge 
the cable 

connector; do not immerse 
in any fluid.

Twist-Lock Connectors

Keep the pins on all connectors free of dirt and moisture by using the soft 
protective dust cap when cable is not attached. 

Cable Vent Tube (Vented Cable)

Vented cable ensures that atmospheric pressure is the reference pressure 
to the vented pressure sensor diaphragm. The vent tube should not be 
blocked, kinked, or otherwise obstructed. Such obstructions will cause 
barometric pressure to appear in measurements, and errors will be 
introduced due to thermal expansion and contraction of air within the vent 
tube and probe body.

The recommended minimum bend radius is 13.5 mm (0.54 in), which is 
twice the cable diameter.

Batteries

Internal batteries in the Level TROLL are not user-replaceable. The 
approximate percentage remaining is displayed on the Win-Situ 5 
Dashboard when the instrument is connected in software. 

Section 9: Care & Maintenance

The minimum 
bend radius for 
vented cable is 

13.5 mm (0.54 in).

TIP: If batteries 
are completely 
exhausted, 

remember that external 
power and battery pack 
options are available.

TIP: Be sure 
to replace the 
desiccant before 

it appears pink. Expired 
desiccant can allow 
water build up in the vent 
tube, causing a blockage 
resulting in inaccurate data.
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Troubleshooting Connections

Problem: Win-Situ 5 Software cannot connect to the Level TROLL 
Instrument.

Probable Cause: Wrong COM port is selected, communication settings 
are incompatible, cable connections are loose or dirty, or batteries are 
low.

Suggested Remedy: Check the following:

•	 All cable connections are tight, connectors are clean and dry.

•	 The cable is securely attached to the instrument.

•	 The correct COM port is selected (select Preferences menu > 
Comm Settings to check this).

•	 The communication settings in Win-Situ and in the Level TROLL 
match. To reset the device communication settings to the serial 
defaults, click “Reset all Devices” in the Comm Settings dialog 
(Preferences menu > Comm Settings).

•	 The internal battery has voltage remaining, or external power is 
supplied.

10  Troubleshooting
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Section 10: Troubleshooting

Problem: Real-time readings are in the wrong units.

Probable Cause: Default units are being used.

Suggested Remedy: Click the Sensors tab, select the sensor, click 
the configure button  and select the desired units for each 
parameter in the Sensor Setup window. Click OK .

Troubleshooting Data Logs

Problem: Cannot add a new log.

Probable Cause 1: Only one active log can reside in the device at a 
time—an active log is a log that is Ready, Pending, Running, or 
Suspended as shown in the Status column of the Logging Tab.

Suggested Remedy: Stop or delete the log if possible. Alternatively, 
configure the new log after the active log is completed.

Probable Cause 2: The device has its maximum number of logs already 
stored—the Level TROLL 300, 500, and Baro TROLL have a capacity 
of 2 logs.

Suggested Remedy: Download, and then delete a log you no longer 
need. This will make room for an additional log on the device

Problem: New log exceeds available memory (message from software).

Probable Cause: The log as configured would exceed the device 
memory.

Suggested Remedy: Edit the log and try these:
•	 Select a longer sampling interval.
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•	 If available, select the Wrap data option (more recent data will 
overwrite older data when the memory is full).

•	 For a log with a scheduled start, select None as the stop condition, 
or select a stop time that is closer to the start time.

Troubleshooting Parameter Configuration

Problem: Cannot configure level or other parameters using the Configure 
button on the Sensors tab. The Sensor setup screen is shown, but the 
Configure... button is dim.

Probable Cause 1: The Level TROLL is actively polling (continually 
updating real-time readings) in the Home tab.

Suggested Remedy: Return to the Home tab and stop real-time readings 
by clicking .

Probable Cause 2: The Level TROLL has an active log—a log that is 
Ready, Pending, Running, or Suspended as shown in the Status 
column of the Logging Tab. Only one active log can reside in the 
device at a time.

Suggested Remedy: Stop or delete the log if possible. Alternatively, 
configure parameters after the log is complete.

Section 10: Troubleshooting
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Index

A
AC adapter,  19
Accessories,  20
Active log,  72
ActiveSync,  21
Analog (4-20 mA)

power,  65
wiring,  61

B
Barometric efficiency,  50
Barometric pressure 

compensation,  50–51,  56
Baro TROLL,  56
Batteries, external,  19
Batteries, internal,  19,  69

C
Cable,  14–17

bend radius,  54,  69
communication cables,  18
Kellems grip,  53

non-vented cable,  55
stripped & tinned,  16,  58,  59
TROLL Com,  31,  42
vented cable,  44,  54,  69
wire,  14,  16,  55,  56

Calibration,  48–49
factory,  48
field,  48–49

Cleaning,  68
decontamination,  12

Clock, setting,  36

D
Data

graphing,  41
logging,  40
viewing,  41

Decimal places displayed in Home 
screen,  35

Declarations of Conformity,  75
Depth, measuring,  44
Desiccant,  17,  42,  54,  69

outboard,  60
removing,  31

F
Factory recalibration,  48

H
Hanger, twist-lock,  20,  55,  56
Home tab (Win-Situ),  34

I
Installation,  52–54

accessories for,  20
non-vented,  55
software,  27

L
Level, measuring,  44
Level TROLL 300,  40,  50–51,  55
Log, active,  72
Logging data

downloading,  41
redundant logging,  65–66
setting up,  40
starting to log,  41

Logging tab (Win-Situ),  40
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Index

M
Maintenance,  68
Maintenance & calibration 

service,  10
Microsoft ActiveSync,  21
Modbus

communication,  65
power,  65
wiring,  63,  64

N
Non-vented Level TROLL,  40,  55

data correction,  50–51
Nose cone,  68

P
Polling,  34
Poll rate, changing,  35
Pressure, measuring,  44
Pressure range,  67
Pressure sensor

absolute vs. gauged,  43–44
do not touch!,  68
non-vented vs. vented,  43–44

Product specifications,  22,  23
Profiling,  34
PSIA,  43
PSIG,  44

R
Real-time readings,  34

units,  35
Repair service,  11
Reset communications,  70

S
SDI-12

communication,  65
power,  65
wiring,  62

Sensors tab (Win-Situ),  45,  49
Serial number,  8
Site,  37–40
Specifications,  22,  23
Storage,  68

T
Temperature range,  67
Thermal stabilization,  54
TROLL Com

attaching to cable,  31
removing,  42

Troubleshooting,  70–72

U
Units,  35,  71

V
Vented cable,  44

bend radius,  54,  69

W
Warranties,  10–12
Win-Situ,  21

BaroMerge,  50–51
connecting to Level TROLL,  32
Control Panel,  34
Dashboard,  34
exiting,  42
installing,  27
redundant logging,  65–66
site,  37–40
Software Manager,  27
system requirements,  21
tabs,  34
Win-Situ Mobile,  21,  27

Wiring
4-20 mA,  61
Modbus RS232,  64
Modbus RS485,  63
SDI-12,  62



 

 

Declaration of Conformity 
 
Manufacturer: In-Situ, Inc. 

 221 East Lincoln Avenue 
 Fort Collins, CO 80524 
 USA 
 
Declares that the following product: 
 
Product name:  Level TROLL  
Model:  Level TROLL 300 
Product Description: The Level TROLL measures and logs level and temperature in natural 

groundwater and surface water.  
 
is in compliance with the following Directives: 
 
 89/336/EEC for Electromagnetic Compatibility (EMC) Directive 
 73/23/EEC for Safety Directive 
 
and meets or exceeds the following international requirements and compliance standards: 
 

• Immunity  
 EN 61326:1997, Electric Equipment for Measurement, Control and Laboratory Use  
 

• Emissions  
 Class A requirements of EN 61326:1997, Electric Equipment for Measurement, Control 

and Laboratory Use 
 
Supplementary Information: 
The device complies with the requirements of the EU Directives 89/336/EEC and 73/23/EEC, and the CE 
mark is affixed accordingly. 
 

 
Todd Campbell 
New Product Development Program Manager 
In-Situ, Inc. 
January 17, 2006 
 



 

 

Declaration of Conformity 
 
Manufacturer: In-Situ, Inc. 

 221 East Lincoln Avenue 
 Fort Collins, CO 80524 
 USA 
 
Declares that the following product: 
 
Product name:  Level TROLL  
Model:  Level TROLL 500 
Product Description: The Level TROLL measures and logs level and temperature in natural 

groundwater and surface water.  
 
is in compliance with the following Directives: 
 
 89/336/EEC for Electromagnetic Compatibility (EMC) Directive 
 73/23/EEC for Safety Directive 
 
and meets or exceeds the following international requirements and compliance standards: 
 

• Immunity  
 EN 61326:1997, Electric Equipment for Measurement, Control and Laboratory Use  
 

• Emissions  
 Class A requirements of EN 61326:1997, Electric Equipment for Measurement, Control 

and Laboratory Use 
 
Supplementary Information: 
The device complies with the requirements of the EU Directives 89/336/EEC and 73/23/EEC, and the CE 
mark is affixed accordingly.  
 

 
Todd Campbell 
New Product Development Program Manager 
In-Situ, Inc. 
January 17, 2006 
 



 

 

Declaration of Conformity 
 
Manufacturer: In-Situ, Inc. 

 221 East Lincoln Avenue 
 Fort Collins, CO 80524 
 USA 
 
Declares that the following product: 
 
Product name:  Level TROLL  
Model:  Level TROLL 700 
Product Description: The Level TROLL measures and logs level and temperature in natural 

groundwater and surface water.  
 
is in compliance with the following Directives: 
 
 89/336/EEC for Electromagnetic Compatibility (EMC) Directive 
 73/23/EEC for Safety Directive 
 
and meets or exceeds the following international requirements and compliance standards: 
 

• Immunity  
 EN 61326:1997, Electric Equipment for Measurement, Control and Laboratory Use  
 

• Emissions  
 Class A requirements of EN 61326:1997, Electric Equipment for Measurement, Control 

and Laboratory Use 
 
Supplementary Information: 
The device complies with the requirements of the EU Directives 89/336/EEC and 73/23/EEC, and the CE 
mark is affixed accordingly. 
 

 
Todd Campbell 
New Product Development Program Manager 
In-Situ, Inc. 
January 17, 2006 
 



 

 

Declaration of Conformity 
 
Manufacturer: In-Situ, Inc. 

 221 East Lincoln Avenue 
 Fort Collins, CO 80524 
 USA 
 
Declares that the following product: 
 
Product name:  Level TROLL  
Product name:  Baro TROLL  
Product Description: The Baro TROLL measures and logs barometric pressure and temperature.  
 
is in compliance with the following Directives: 
 
 89/336/EEC for Electromagnetic Compatibility (EMC) Directive 
 73/23/EEC for Safety Directive 
 
and meets or exceeds the following international requirements and compliance standards: 
 

• Immunity  
 EN 61326:1997, Electric Equipment for Measurement, Control and Laboratory Use  
 

• Emissions  
 Class A requirements of EN 61326:1997, Electric Equipment for Measurement, Control 

and Laboratory Use 
 
Supplementary Information: 
The device complies with the requirements of the EU Directives 89/336/EEC and 73/23/EEC, and the CE 
mark is affixed accordingly.  
 

 
Todd Campbell 
New Product Development Program Manager 
In-Situ, Inc. 
January 17, 2006 
 
 



 

 

Declaration of Conformity 
 
Manufacturer: In-Situ, Inc. 

 221 East Lincoln Avenue 
 Fort Collins, CO 80524 
 USA 
 
Declares that the following product: 
 
Product name:  TROLL Com 
Model:  USB TROLL Com 
Product Description: RS485 to USB converter  
 
is in compliance with the following Directive 
 
 89/336/EEC for Electromagnetic Compatibility (EMC) Directive 
 73/23/EEC for Safety Directive  
 
and meets or exceeds the following international requirements and compliance standards: 
 

• Immunity  
 EN 61326, Electrical Equipment for Measurement, Control and Laboratory Use, Industrial 

Location 
 

• Emissions  
 Class A requirements of EN 61326, Electrical Equipment for Measurement, Control and 

Laboratory Use 
 
Supplementary Information: 
The device complies with the requirements of the EU Directives 89/336/EEC and 73/23/EEC, and the CE 
mark is affixed accordingly. 
 

 
Todd Campbell 
New Product Development Program Manager 
In-Situ, Inc. 
June 17, 2006 
 


